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I do this in my spare time so debugging is inadequate.  I will send out repairs if needed.  Please 
report any difficulties.  If I can reproduce a flaw, I can fix it. 

 
Upgrade Notes, June 2005 

Improved the Legend and added/repaired many diagrams. Added a text box to calculator. 
 

Upgrade Notes, February 2005 
Added a Legend and many smaller improvements and repairs 

 
Upgrade Notes, March 2004 

Major upgrade. Significant change in programming environment, serious attempt to fix 
international problems involving erroneous truncation of numbers after local decimal characters 
that are not  a “.” But are instead a “,” Added IUGS classification. 

 
Upgrade Notes, June 2002 

Substantial improvements to make Igpet work with Windows XP.  Added several more 
discrimination diagrams and reconfigured several dgm files. 

 
Upgrade Notes, April 2001 

Repaired CoDoPo option in Spider modeling. Added a few more dgm files. Fixed minor errors. 
 

Upgrade Notes, March 2000 
Igpet uses windows metafiles (.WMF) to transfer graphics to the clipboard and store them on a 
disk.  Earlier Igpet versions relied on a background page to keep aspect ratios in place.  This 
backpage is now an option because it was difficult to remove it in MS PowerPoint and MS 
Word.  Not including a backpage allows Igpet plots to occupy a smaller footprint on a Word 
page, just the diagram and an inch or so of surrounding space.  Word or PowerPoint can then add 
additional comments on top.   
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Installing Igpet 
 

Igpet will not work on Windows 3.1.  Install it only on a 32-bit system, such as Windows 95 and 
higher.  A setup program, SetupIgpet05.exe, installs Igpet.  All of Igpet's control files and all the 
data files shipped with Igpet will be copied to a directory, normally Igpet205, in Program Files. 
 

Tutorial 
 
The best way to learn Igpet is to use it on one of the data files shipped with it. The next few 
pages leads you through the major features available in Histograms, XY plots, Tri plots and 
Spider diagrams.  Along the way, most of the functionality in Igpet is demonstrated.  So, from the 
Windows Start Menu select: Igpet05. The main Igpet window appears.  Options can be selected 
by clicking menu items or buttons. 
 
Read a File 
First, click menu File, Open File, then use the file dialog box to select a data file with an 
extension like .TXT, .ROC, .MIN.   For this tour select FUSAMA.TXT.  After the data are read 
the Plot menu is activated.  
 
Make a Histogram 
Click menu Plot, Histogram and you will be asked to select the X-axis variable for a histogram 
using the Variable Menu, which includes a primitive calculator. 
 
Calculator 
Igpet's calculator consists of a row of operations and a row of buffers that store the results of the 
operations. You can convert from oxides to ppm, normalize an element to its mantle source value 
(S-norm), etc. You can add, subtract, multiply, or divide. When you make an operation, the result 
is stored in one of the buffers, and the new name is listed in the row of buffer buttons.  Quite 
complex equations can be put together and their names may get too long to be completely listed 
in the available space. This is not a problem as long as you remember what you are doing. When 
you run out of buffers, the program goes back to and overwrites the first buffer. 
 
A text box, below the calculator, allows you to directly enter simple equations, bypassing the 
calculator. The recursion routine is not yet smart enough to handle Log(xx), but otherwise seems 
fairly robust. It is experimental (June 05), so please report problems. 
 
The Histogram function plots bins using the color of the symbol for each analysis.  To make a 
more pleasing looking histogram you can select Symbols from the Edit Menu and click the One 
symbol for all button.  Draw a normal curve on the histogram using the Distrib button. This 
function uses the mean, std. dev., N and bin definition to scale the normal curve.  Statisticians 
recommend beginning any examination of data by first looking at univariate statistics. 
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Make an XY plot 
Click the menus Plot, XY and you will be asked to select the X-axis variable. Select X, and then 
select Y in the same way. A graph will now appear on the screen. 
 
Buttons above the graph allows you to change the diagram and make some petrologic 
calculations.  A plot of SiO2 vs. K2O is useful to show the uses of these buttons, so if you have 
plotted something else, click on New X or New Y to create a SiO2 vs. K2O plot. 
 
Identify a particular data point 
The FUSAMA file includes analyses from a high-alumina volcano (Fuego in Guatemala), a calc-
alkaline volcano (Santa Ana in El Salvador) and a tholeiitic volcano (Masaya in Nicaragua). You 
can determine which symbols stand for which volcano by clicking ID ON. The identify function 
starts by causing the first sample to flash on the screen.  The sample name is shown just to the 
right of the top line of buttons. Now move the mouse to any data point and click. This sample 
will flash and its name will be written.  Use the newly activated buttons, Next and Prev, to move 
forward and back through the data, highlighting successive data points.  To pick one sample from 
a list, click on Pick. A column of sample names will appear. Double-click SA206. This is the 
most mafic sample from Santa Ana and it should now be flashing.  The Name button will give 
you a quick look at where all the samples plot. 
 
The identify buttons allow you to get to know your data. Furthermore, they are essential for 
selecting endpoints for the Mix and Model options. 
 
Add a Legend 
The Legend button asks you to select a legend file.  There is a legend file for the Fusama data, 
called: FusamaLegend.txt.  Use this file as a model for creating custom legend files for your own 
data.  These files are tab delimited text files that are easily made with Excel.  The first column is 
an integer, a key to a symbol, the second column is a name or description. 
 
Edit Menu 
Fine-tune the X and Y axes 
Igpet automatically scales the X and Y axes based on the spread of data. This is convenient for 
quick looks, but it can be very misleading, especially if one or both axes has a small range of 
variation. Here, the computer can make you imagine variation, when, in fact, the spread is noise. 
 
To change the axes, click the Axes button near the top of the main window. You get a list of 
parameters you can edit. Most are self-explanatory but the choice of the interval to draw long 
ticks may take some practice. If you want just small ticks enter 0. The most commonly used 
values for long ticks are 2, 5 and 10. Just experiment and find out what you like. 
 
Switch the X and Y axes 
The button XY-YX allows you to instantly switch the axes. 
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Change aspect ratio or position of a graph 
Aspect Ratio in the Edit Menu allows you to change the shape of your graph and to change the 
position it will occupy on a printed page.  The default aspect ratio for Igpet is a rectangle, 
suitable for 35mm slides. In many instances it is better to use a square or box.  A final option 
allows you to customize the shape (within limits) to suit your purpose. 
 
The Position of the graph can be selected from a list of options in the Edit Menu, Position. 
These positions are specified in a file called Page.dia. Using Notepad, you can modify them to 
suit your needs. See Appendix A for details. 
 
View a third dimension  
Write Values in the Edit Menu lets you display on the current plot the value of any parameter 
available through the calculator. For example, on the SiO2 vs. K2O plot, you can write the TiO2 
values of each sample.  Click Write Values again to remove the numbers. 
 
Select subgroups with symbols  
Because there are three volcanoes in FUSAMA, a linear regression would have little meaning. 
The easy way to eliminate two of the volcanoes is to click Symbols in the Edit Menu. 
 
Click Refresh to see the symbols.  A symbol is eliminated by clicking on the adjacent check box.  
To select just the Santa Ana data, note the position of the open red circles.  Click Deselect All, 
then click the check boxes adjacent to open red circles.  Now only Santa Ana data will be plotted. 
 
The c buttons in the line and fill columns allow you to change the color of symbols or lines using 
the Windows color dialog.  You can explore more pleasing combinations and save the RGB 
definitions of the colors in a file, like mysyms.sym, if you wish to make a new symbol file. 
 
Take a minute to examine other options. 
 
Basis for Symbols allows four choices for controlling symbols, Jcode, Kcode, Lcode and Scale 
to Variable. The first three are parameter names in data files that Igpet recognizes as potential 
symbol codes. Having three symbol parameters is probably overkill, but you may find it useful to 
subdivide your samples into different subsets on totally independent criteria, such as stratigraphic 
grouping; petrographic characteristics; TiO2 concentration, shape of REE pattern, etc. The Scale 
to Variable button allows a plot to be "contoured" by plotting different symbols for different 
ranges of a parameter. For MORBs, a plot of water depth versus Na2O, contoured in MgO, is a 
useful way to look at this correlation, proposed by Klein and Langmuir (1987). This is analogous 
to the Value button described above. 
 
New Size allows you to modify the sizes of the symbols, shrinking or enlarging them all. This is 
a useful fine adjustment when you are making a publication quality diagram. 
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Black syms make symbols more visible on laptop screens.  It also allows you to remove the 
effects of a black and white printer's effort to reproduce color by drawing dithered shades of gray.  
Some of these effects are pleasant, but others are ugly.  Dflt sym col reverses the effect of Black 
syms.   You can use the file, grey.sym, to get greyscale symbols. In the Symbols page click New 
sym file. 
 
Tie Lines draws tie lines between each successive datum, which is nice if the data are in some 
kind of order (e.g. stratigraphic height). but creates a mess in most circumstances. 
 
1 sym for all allow you to pick one symbol that will be used for all the points. 
 
The Font Style button brings up the font dialog box.  It is best to stick with True Type fonts.  
These have the best chance of staying the same and looking good on all output devices. 
 
Three edit fields for line widths allow you to control how fat the lines are in Igpet.  The useful 
range is from 1 to 15 or 20.  The colored margins of symbols may be invisible on black and white 
printers because of dithering.  If so, use Black Syms and the symbol borders will reappear. 
 
Four buttons control background colors.  The screen and all output devices have two colored 
areas, one for the page and one for the XY box or TRI polygon. The advent of color printers 
created a desire to print in vibrant color. Furthermore, one can transfer colored diagrams to 
graphics programs, like CorelDraw, and have slides made directly from CorelDraw pages.  
Pagecolor and Boxcolor let you set these two areas to any possible color.  Whitepage and 
Defaultcolor do what their names imply. 
 
The edit fields, pg width and pg length control the logical page size. Regardless of whether you 
finally send output as Portrait or Landscape images, the width and lengths here are always the 
dimensions for Portrait mode.  This control may help you pass graphics more perfectly to 
different draw programs.  The reason it is included is that Micrographxs Draw, CorelDraw’s 
clipboard-paste and CorelDraw’s WMF-import all appear to use slightly different default page 
sizes. 
 
Now click OK and return to the main screen. 
 
Set Limits to exclude some data 
The Set Limits option in the Edit Menu allows you to filter your data through two possible 
windows.  Some of the high silica samples of Santa Ana are from domes at the adjacent 
Coatepeque caldera. Including them in a linear regression might be a mistake, so click on Set 
Limits to eliminate them. A list of parameters appears.  Double-click on SiO2. For a lower limit 
enter 0, for an upper limit enter 58.  For the second limit select Quit or OK.  A graph without the 
high silica points will now appear. 
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Linear regression calculation 
Click on the Regress button to draw a linear regression line.  The line can be drawn through 
either the range of X-values or the length of the X-axis.  After the line is plotted, the slope, 
intercept, R2, r, r', n, t and F appear in a window. The slope and intercept and their errors (+- 1 
SD) are in scientific format (thus 1.16E-01 = 0.116).  After making any needed notes on the 
regression parameters, click OK to go on.   
 
Regression parameters (slope, slope error, intercept, intercept error) can be printed on the 
diagram or saved to a file called "Stat.ig".  Next, you are asked to add the line to the plot or not. 
 
Sometimes you may want to plot all the data, but calculate a regression on just a subset. If the 
data to be excluded have a different symbol, you can use the Symbols option to temporarily 
exclude the unwanted data.  You can use the Set Limits button in similar fashion. 
 
Notes above the diagrams 
As mentioned above, regression results can be printed above the diagram. Before copying the 
plot to Word or PowerPoint you can remove the extra notes using the NB off toggle button. 
 
Hyperbolic mixing 
The Mix-Two Endpoints button uses the equations derived by Langmuir et al. (1977). It works 
for isotopic ratios (Sr, Nd, Pb), oxides or elements, oxide or element ratios and the ppm, source 
normalization and Log options on the calculator. It will not work for complex equations. 
 
First, you need to use the identify buttons (ID ON) to choose which samples to use as endpoints. 
Once you have selected endpoints, click Mix. 
 
Second, select the first and second endpoints using double-clicks.  
 
Third, pick one of four options for plotting tick marks on the mixing curve. Except for option N 
(none) six ticks will be plotted. The values for the options in % are: 
 E 0 20 40 60 80 100 
 S 0 0.5 1 3 12 60 
 T 0 0.1 0.2 0.3 0.4 0.5 
 
Finally, you can limit the hyperbola to between the endpoints or allow it to span the X-axis. For a 
simple linear plot, like SiO2 vs. K2O, the hyperbola becomes a straight line. I'm not sure there are 
any interesting mixing plots for FUSAMA but there are in the file CENTAM.ROC. These data 
will allow you to reproduce the diagrams in Carr et al., (1990). 
 
The Mix-Least Squares button fits a hyperbola to all the data visible on the screen.  This will 
produce a mess unless you have a well defined curve.  It is best to use this on a plot like a/b vs. 
c/d.  Because it is quite a fussy equation to fit, a success is a strong positive indicator of mixing, 
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providing, of course, that field data, thin section observations and basic geochemical patterns 
indicate mixing.  A failure here suggests that a mixing case may have imprecise data or that AFC 
is operating, so the case is not simple. 
 
 
Model 
Model allows you to calculate paths for fractional or equilibrium crystallization or the AFC 
(assimilation-fractional crystallization) process. To examine the AFC capabilities properly, you 
should get DePaolo (1981) and read the file DEPAOLO.ROC. This file will allow you to 
reproduce Figure 3 in DePaolo's article and, in the process, learn how this modeling works. 
 
For the Santa Ana graph of SiO2 vs. K2O, use ID ON to locate a "parent" on the lower left side of 
the data array. Now click Model.  Select FC for fractional crystallization. Then select the 
"parent" (Co) and the model parameters. Bulk distribution coefficients of 0.7 for SiO2 and 0.01 
for K2O are good starting points. You can make several models and make a real mess of the 
graph if you save all your models. To clean it up, click Aspect, then Quit. A pad of paper is 
useful to remember what models are worth including in a final plot.  Overall, this option is a 
useful first pass, qualitative way to develop a FC, EC or AFC model.  To do this properly you 
need to consider all pertinent elements at once and include realistic modal and partition 
coefficient data.  This is done in the model option available with spider diagrams. 
 
Make a Triangular Plot 
Triangular plots are created from the Plot Menu with the same calculator used for XY plots. To 
make a triangular plot, click Plot TRI. You will be asked to define the three end members, X, Y, 
Z, (e.g. Na2O+K2O, Feo+.8998*Fe2O3, MgO).  (Note:  0.8998 can be inserted in a buffer by 
pressing C for "constant") 
 
A new button appears, Quad, which allows you to cut off one or more corners of the triangle. 
Cut the top by specifying 0, .5 when asked for the Min, Max of the Top Apex. This will give a 
quadrilateral. Cutting the extent of the triangle may allow it to be drawn at a larger size and Igpet 
will do so automatically. 
 
Make a Spider plot 
Spider diagrams are great way to see large variations in incompatible elements at a glance.  
Because of the log scale you cannot see the detail seen in XY plots, especially plots of 
incompatible element ratios.  Nevertheless, it is a powerful tool.  Unfortunately, it is also a 
source of Babel because there are new spider diagrams almost in each issue of a geochemical 
journal. The best spider diagram will eventually win out (I hope).  The best, according to 
reviewers of my work, is primitive mantle normalized.  The one by Sun and McDonough (1989) 
is a good one and I now use it almost exclusively, except, of course, for REEs.  The general idea 
of a spider plot is best expressed in the “classic”, the REE plot.  The most incompatible element 
is on the left, the least incompatible element is on the right.  The spacing between elements 
would ideally be related to degree of incompatibility but most diagrams use an ordinal scale to 
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make life easy for draftsmen and computer programmers.  For REEs this leads to blank spaces 
for elements not determined in particular instruments.  In Igpet the missing elements show up on 
the x-axis but no symbol appears (e.g. Pm and Tb). 
 
Repick, NewSpi and Y-Scale are special buttons for the spider diagrams.   To see them, first 
select File-Open File Centam.txt.  Now, select Spider from the Plot menu. From the list of 
choices that appears try REEs first, by double-clicking on the top entry.  Next select a few 
samples to plot from the list that appears by double-clicking GUM4 and GUT102, from Moyuta 
and Tecuamburro volcanoes in Guatemala.  Use Repick to select different samples, NewSpi to 
pick a different spider diagram, or Y-Scale to fine-tune the Y-axis.  Nrm/Samp allows you to 
switch to one of your samples as the normalizing standard. That sample plots horizontally at 1. 
 
Modeling and Mixing in Spider plots  
Elaborate partial melting and simple crystallization models can be performed when a spider 
diagram is plotted.  This requires partition coefficient files (*.pcs), a starting composition, and 
knowledge of melting models.  The book by Francis Albarede, Introduction to Geochemical 
Modeling

Output Options 

, should be read carefully before using these modeling tools.  To see examples of how 
this powerful set of options can be used, see Feigenson et al. (1996) or look for Patino et al. 
(2000).  The CoDoPo option in spider modeling uses a trace element inversion method 
developed by Feigenson and Hoffman and used in Feigenson et al. (1996). 
 
Explore the Mix option by clicking the button.  You can select up to 5 samples that can be mixed 
using integer weights, decimal fractions or %s. Thus, 3,1 and .75, .25 and 75, 25 produce the 
same result when mixing two samples.  You can average 5 samples by selecting them and giving 
each a weight of 1.  More interesting would be modeling a specific mantle by mixing 
components, for example, by adding 95 DMM and 5 HIMU, etc, etc.  You can bail out of the 
Mix function using the Quit button. 
 
The Model option is best at modeling melting processes.  You start by selecting a model, e.g. 
Batch Melt, then you select whether melting is modal or non-modal (Pi’s<> Di’s). Finally you 
get to a window that allows you to pick a partition coefficient file (a pcs file), a mantle mode, a 
melt mode (if non modal melting), and a set of % melts.  You can run the melt equation forward 
(the default) or backward by toggling radio buttons.  When all is set, click the Make 
Calculations button, the bulk D’s will appear, then the models will be plotted on the spider 
diagram as black crosses.  Unlike the simple models in the XY plot, these data are now added to 
the data in memory, so you can go on to make XY plots, especially ratio versus ratio diagrams, to 
look in detail at your models.  To save any models permanently, you must go to File-File 
Operations menu and Save the file.  Usually, it is best to save the file using a new name. 
 

Before printing or saving a diagram, explore the buttons of the lower left side of the main 
window. For printing, the colored backgrounds can waste a lot of ink on drafts, so a two options 
in the Edit Menu allow one to switch back and forth between colored (color) and white (white) 
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rectangles.  If you don’t like colors at all, you can set the defaults to white (255,255,255) in your 
favorite sym file.  Change boxcolor and pagecolor, located near the end of the file. Use the 
Windows Notepad accessory. See section below on *.sym files. 
 
You can change the orientation of the y-axis label using two options in the Edit Menu.  The 
reason for this is that vertical fonts to not pass unscathed through the Clipboard or a Windows 
metafile (WMF) and then onward to a word processor or graphics program.  CorelDraw almost 
translates them properly, but Micrographxs draw programs and Microsoft Word do not allow 
them.  To pass diagrams to a graphics program or word processor, it is best to send them as 
horizontal fonts and rotate them after you get them there, so Igpet does this automatically.  The 
default orientation of Y axis labels can be set in the Preferences menu.  The vertical choice is 
valid only for the Screen and Printer. 
 
Print 
The Print option in the File Menu sends output to the printer.  You first are asked if this is the 
last plot on a page. This query allows you to place several diagrams on a page rather than printing 
just one. Just keep track of what you are doing!  The printer dialog box will not appear until you 
click Yes. 
 
If your first plot, using a vertical Y-axis label, comes out reversed or odd, then you need to 
change the Printer’s Y-axis setting in the Preferences menu.  The default, as shipped, is 90º 
which works for HP LaserJets in normal configuration.  HP inkjet printers prefer the more logical 
value of 270º.  Make changes in the Preferences window and be sure to save the new 
preferences! 
 
Clipboard from Edit Menu 
The clipboard is an easy way to transfer a diagram to a draw program or word processor. The 
Copy to clipboard option in the Edit menu option asks you to choose between Diagram and 
Diagram and background page. Usually, the diagram option is best.  However, if you want to 
sequentially copy several diagrams onto specific sections of a page, use the background page 
option. However, when pasting into a draw program, you will have to ungroup each successive 
diagram and remove its background page.   
 
To see your diagram on the clipboard, activate the Windows Clipboard Viewer. If you have a 
diagram on the clipboard and want to place it in a Microsoft Word document, move the cursor to 
where you want it, then open the Draw window (its symbol is the triangle, circle and box).  Paste 
the diagram into the Draw window, where it can be edited.  You can just paste the diagram in the 
Word.  Clipboard graphics cannot be modified in Micrographxs Designer. 
 
Save Diagram to wmf file from File Menu 
Windows metafiles are lists of Graphics Device Interface (GDI) calls that create a vector graphic.  
You can save a diagram for later import into a draw program or word processor by clicking this 
menu option.  First, choose between Diagram and Diagram and background page as in the 
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copy to clipboard option. A file dialog box will open.  Keep the .wmf extension

PREFERENCES 

 because that 
identifies the file type.  Microsoft Word and PowerPoint, CorelDraw and Micrographx's Draw 
and Designer treat these files differently, but will import *.wmf files.  The size of a diagram is 
preserved but the placement on the page may not.  Put one diagram in each *.wmf. 
 

 
The Preferences menu brings up a window that allows you to customize Igpet. Three buttons 
allow you to specify the path to the directory where you keep your data files, the file used for 
symbols and the file used to read the normalization factors for the S-norm function in the 
Calculator.  Radio buttons allow you to select three other options.  The first is a file filter, that 
allows you to set limits on the data that will be read from a large data file.  The other two allow 
the y-axis labels to survive printing and transfer to graphics programs.  The orientation of the Y-
Label should be Horizontal for transferring graphs to graphics programs or word processors.  The 
Printer’s Y-axis can be toggled to fix garbled vertical y-axis labels on your printer; rather than 
adjust your printer, adjust this setting in Igpet. 
 
Near the upper left of the preferences window is a box. It is advantageous to scale the size of 
Igpet to a decimal fraction of your screen, this allows Igpet to be a moveable window, rather than 
filling the whole screen.  In 800 by 600 mode I commonly use 0.95 to allow the task bar to stay 
visible.  Put in a number less than 1 (e.g. 0.90).  
 
The changes you make in preferences will not do much unless you save them. Your choices go 
into igpref.ini for use the next time you start Igpet. The radio buttons and any changes to the 
Misc area take immediate effect but other changes do not. 
 

DATA HANDLING in the FILE menu 
 
Options for Additional Parameters 
Igpet can calculate and store in RAM a large number of parameters derived from the major and 
trace element values. The derived parameters can be saved to a file, but this is not usually 
worthwhile, because it is slower to read such data, than it is to calculate it. If you want to transfer 
some of these parameters to a spreadsheet, then it may be worthwhile. Before adding derived 
parameters make sure the data matrix has enough room. 
 
Reset Matrix Size (File Menu) 
If you plan to add optional data fields, you should check the current size of the data matrix before 
you read your data file. Click this menu item to see default matrix size.  The first number (rows) 
tells you the maximum number of analyses. The second number (columns) tells you how many 
fields are allowed. You start with the number of fields in your data file.  Then add the following: 
  CIPW  26 
  Pearce  17 or more  
  Extra    7 or more 
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  Normalize   1 
 
Putting all this stuff into the data matrix means adding about 50 fields. It makes the calculator 
difficult to use and is usually not necessary. The best plan is spend a session working with the 
CIPW Norm, then re-read your data file and work with the other parameters. 
 
The single data field added by the Normalize routine will be unloaded if nothing else has 
subsequently been loaded. The other parameters can't be unloaded, to get rid of them, you have to 
re-read your data file. 
 
Norm to 100% (File Menu: normalize to 100%, water free, Fe as FeO) 
If there is a limited range of silica values (e.g. 49-55) in a suite, scalar effects will appear large. 
The largest analytical error is usually silica, just because it is more than half of most rocks. Other 
scalar errors occur if the rock is altered (added water, oxidation of FeO, etc.). Furthermore, most 
analyses are subject to minor systematic or gravimetric errors leading to values that are slightly 
high or low. If errors like these occur then silica will be visibly affected, whereas K2O or other 
oxides will appear unchanged.  This is the general rationale for using this subroutine. These 
effects are part of the closure problem (Chayes, 1964) and Pearce element ratios (Pearce, 1968) 
are a way of reducing the problem. 
This routine finds oxides of 13 elements: Si, Ti, Al, Fe+++ ,Fe++ ,Mn, Mg, Ca, Na, K, P, Cr, Ni 
and sets an index parameter which tells Igpet to multiply these oxides, just before plotting, by:   

100/(Sum of oxides), in which Fe2O3=0 and FeO=FeO+.8998*Fe2O3. 
The original data are not changed so you can turn Normalization on and off without getting round 
off errors. A new parameter, FeOt, is added. It is total Fe, normalized to 100%.  This new 
parameter will be removed when you turn Normalization off, unless you have subsequently 
added other parameters.   
 
If you want to normalize trace elements by the same factor as the major elements answer "Yes" to 
get a list of data fields. The major elements are preceded with * indicating that they will be 
normalized. To do the same for any trace elements, double-click the element. When done, move 
to Quit at the end or beginning and double-click, or click OK. 
 
Resetting the Ferric/Ferrous ratio 
Because many data sets present all the Fe as either Fe2O3 or FeO, there is a need to apportion the 
Fe in a reasonable way. For Pearce element ratios and CMAS projections Igpet has a subroutine 
that uses the logic of Sack et al. (1980) to reset the Fe oxides. If you chose to reset this ratio, you 
will be asked for a Temperature (Centigrade) and fO2. The default T, fO2 are stored in igpref.ini 
and can be changed in the Preferences window under Miscellaneous.  The values 1150º and -
8.16 (the defaults as shipped) are approximately on the NNO buffer. 
 
Irvine and Baragar (1971) based rock identification on the CIPW Norm. They recalculated FeO 
and Fe2O3 using Fe2O3=1.5+TiO2. If the analysis value is less than this, no change is made. 
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In the Minerals subroutine, the charge balance logic of Lindsley and Anderson (1983) is followed 
to partition the Fe oxides before plotting pyroxenes on the geothermometer. 
 
Extra Param. (File Menu) 
Commonly used calculations can be stored here and automatically made, rather than using Igpet's 
calculator. The data file "EXTRA.DIA" is described in Appendix A. It includes a few standard 
parameters.  The parameter FeO* is FeO+0.8998* Fe2O3 and it has not been normalized.  Mg# 
is 100*MgO/(MgO+FeO+0.8998* Fe2O3), where the oxides are first divided by their molecular 
weights.  Ba/La and La/Yb are just what they say. There are three built in parameters. Ce* and 
Eu* are normalized values obtained by log interpolation from adjacent REEs.  Density is 
calculated on a normalized basis, using the method of Bottinga and Weill (1970). It will always 
be last on the list of extra parameters. 
 
Pearce Param. (File Menu) 
The problem of closure in rock analyses (they add to 100% more or less) makes interpretation of 
traditional Harker (SiO2) and Fenner (MgO) diagrams inconclusive (see Chayes, 1964). These 
diagrams allow no simple determination of which minerals or combinations of minerals are being 
removed (or added) to a magma. The basic problem is that whatever direction SiO2 is going, 
most other oxides must perforce go in the other. What is worse is that although a large 
percentage of what is removed is SiO2, it usually will go up anyway.  
 
A partial solution to the closure problem is to divide the X and Y variables by a common, highly 
incompatible or conserved element, like K in arc lavas or Ti in tholeiitic basalts.  Explaining 
specific combinations of oxides that will test for the removal of one or more minerals is outside 
the scope of this guide. Please refer to Pearce (1968), Russell and Nicholls (1988), Stanley and 
Russell (1989), Russell et al. (1990), Defant and Nielsen (1990). 
 
To test the utility of Pearce Element Ratio diagrams (PER diagrams), read the file, 
"BOQUERON.ROC". Fairbrothers et al. (1978) showed that an older suite at Boqueron had a 
calcalkaline fractionation trend caused by removal of nearly equal proportions of plag and cpx 
{pl/(cpx+pl)=0.55}; whereas the recent lavas had a tholeiitic trend caused by removal of much 
more plag than cpx {pl/(pl+cpx)=.72}. Olivine, opx and magnetite play a minor role. This result 
was obtained tediously by making a great many least squares mixing calculations. 
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Now test this with a PER diagram. Let X be (2Ca+Na)/K and let Y be Al/K (Russell and 
Nicholls, 1988). In this projection the slope of the regression should be pl/(pl+cpx) and ol will 
have no effect. The open diamonds are the early calc-alkaline suite and the small circles are the 
recent tholeiitic lavas. A filled diamond, not shown above) is a back-arc cinder cone. Use the 
Symbols routine to select one suite and then the other. Make a regression for each. The slope is 
the pl/(pl+cpx) ratio. The PER diagram method reaches the Fairbrothers et al. conclusion in a 
flash.   
 
CIPW Norms (File Menu) 
The CIPW Norm is familiar to most geologists. Adding a Norm is essential for the Irvine and 
Baragar (1971) classification scheme, which is covered in one of the special diagram options. 
Igpet's CIPW is not complete, but it is serviceable for most uses. The normalization subroutine 
described above does not affect the data that are input to the CIPW subroutine, so, you are asked 
again if you want to normalize the data to 100% before calculating the Norm. 
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ROCK AND MINERAL DATA FILES 
 

Igpet’s file reading logic uses tab delimited txt files, an ASCII or flat text file.  The file begins 
with a row of names, one for each column or data field.  Columns are separated using tabs.  
Oxides and other data can be in any order. 
 
Earlier Igpet files used comma delimiters.  These files can no longer be read by Igpet. A 
translation utility, translate.exe, changes the older format to tab delimited text. 
 
Tab delimited data file structure 
The first row is the list of column/field names; each subsequent row is an analysis. 
 
dum Jcode Kcode Lcode sample SiO[2] TiO[2] Al[2]O[3] etc. 
81 1 4 4 PLA7 50.89 .879 20.21  etc. 
81 1 4 4 PLA8  etc. 
 
Each row is read as a single string and then parsed. 
 
Format features  
The [2] and [3] in the parameter names signify that these are subscripted variables in plots. 
Similarly, {87} or {86} define superscripts. The first line has 5 reserved words, two of which, 
Sample and Kcode, should be included in any file. 
 
Sample  the sample name, a string variable 
Jcode   an integer that can be used to control the symbols in plots.   
Kcode   integer variable that is the default control for symbols. 
Lcode   an integer that can also be used to control the symbols. 
dum   placeholder that allows Igpet to ignore any columns not needed. 
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Using Igpet's File Operations 
 
From the File Menu click File Operations. This menu gives you nine choices. 
 
Print a table 
This option allows you to print a list of analyses, where each one is a vertical column. 
 
The table can be sent to: screen (to preview or examine the data set) 
    file  (best option for publication, because you can edit it) 
 
You are first asked "How many columns of data?". Suitable values for the screen and printer are 
listed.   Next, comes a grid that you fill with the number of decimal places for each field.  To 
start this click the edit field in the upper left.  All data entry is at that point.  Type the first 
integer, press the Enter key, type the next integer etc.  When done click OK/Save 
 
The next page asks if you want to calculate a total.  If you answer yes, you get the grid again, but 
this time enter 1 if you want to include the field in the total. When done click OK/Save. 
 
Next you get a choice of three output buttons.  Select Screen.  Now the table is printed. If you 
don't like how it looks on the screen, you can correct the choices you made and print it again.  
Get it right on the screen before you send it elsewhere. 
 
To stuff more columns on a page, send the output to a file. Pick it up there with a word processor 
and use a small, monospaced font to allow more columns to be packed onto a page. Trial and 
error needed here, the number of columns you can squeeze in depends on both the printer and the 
word processor. For printing with a word processor it is critical to use a monospaced font. 
Proportional fonts cause havoc. 
 
Modify  
This is very useful for looking at the data.  A grid is presented with all the data.  You can move 
around in the grid and edit any datum by double-clicking and then editing it. 
 
Any changes made here will be reflected in subsequent plots only after NewX, NewY or 
Symbols has been clicked (depending on what you changed).  No change has been made in the 
original data file on the disk. To change the data file, you must use the Save option. 
 
Enter data 
If no file has been read, you get a page of instructions when you select this option. The purpose 
of the instructions is to get a correct list of the data fields you want to enter in the order that Igpet 
will save them in.  The next page allows you to change the order in which you enter the data. 
This is convenient if your data list (e.g. output from an analytical instrument) is in an odd order. 
This option should save some mental strain because it allows you to type the data in the order 
they are listed, but they will be saved in the order you previously specified. 
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If a file resides in memory and you select "Type in data"  you can to add to the data file using the 
format of that file. 
 
Clear all data  
If a file resides in memory, this allows you to clear it out, so you can start fresh. 
 
Save file  
Warning except for sample name all text data will be turned to zero. Use a new name! 
The file save dialog box opens and you select a new name and or extension.  
 
Add a file (Merge Files)  
This option allows you to merge two files that have different (or the same) formats. There is a 
catch. If the second file has data fields that the first file lacks, these data fields will not be part of 
the new joint file.  This option is useful for adding mineral analyses to a ROC file. 
 
Read the Clipbrd 
Small files can be passed between applications via the clipboard.  If you have clipped a file in 
your spreadsheet or word processor, click this button and Igpet will read it.  Reading is slow 
because the clipboard is one large string that has to be parsed.  Files larger than 150 by 50 may 
not fit on the clipboard. 
 
Copy file to Clipbrd 
Sends current data file to clipboard, so you can paste it into a spreadsheet. 
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Import/Export of files 
 
Data files to and from spreadsheets via .txt files  
Excel and some other spreadsheets can write tab delimited txt files.  Use Excel to maintain your 
data files in its native *.xls format.  When you are ready to make some plots, save the data file as 
a tab delimited text file (a *.txt file). Use your spreadsheet to update data files; it is much more 
efficient than a text editor or Igpet’s crude file operations grid.   
 
Using a word processor to make files 
Most word processors have the ability save their work into ASCII files. The file structure needed 
for Igpet is shown above. It is straightforward to enter the data in the correct order as specified 
above. If you are going to take this route, by all means try it first on a short file, one or two 
analyses, until you have the process ironed out. 
 
 

Notes on Applications 
 
Multiple diagrams per page 
Fenner.DGM and Harker.DGM are multiple MgO and SiO2 plots respectively. On a printer the 
eight sub diagrams in each file will be packed into two rows on the same page. This is a handy 
way to make a quick survey of a data set. When you are satisfied with the first diagram, click 
Print. After the plot is sent to the printer, answer NO when asked if this is the last plot on the 
page. End the plot only after the eighth diagram is done.  
 
DiscrimBasalt.DGM, Granite.DGM, Komatii.DGM, Mantle.DGM, Petrol.DGM, Irvbar.DGM 
etc. are groups of diagrams that attempt to define (or discriminate) the tectonic environment of 
rock suites or that provide useful nomenclature. Irvbar.DGM is the Irvine and Baragar (1971) 
rock classification scheme. The plotting parameters for the DiscrimBasalt file are mostly from 
Rollinson (1993). For proper use, these discrimination diagrams should be used only in 
conjunction with Rollinson (1993) or  the original references!  
 
Two DGM files cover the IUGS Cation NORM classification, based on Streckeisen and Le 
Maitre (1979) and the IUGS Modal classification (Streckeisen, 1976).  The first DGM file 
requires you to add a CIPW norm using the Barth-Niggli Cation Norm option (look in the File 
menu).  The second DGM is based on Petrography, real point counts. This should not be used 
with the CIPW Normative minerals.  Instead, add columns of data in your spreadsheet with 
mineral modes (and combinations of minerals).  The mineral names I used are: plagioclase, 
orthopyroxene, clinopyroxene, olivine, hornblende, quartz, feldspathoids (a combination- see 
ref.), alkali_feldspar (another combination).  
 
Mineral Diagrams 
Some simple mineral plots are created by the control file MINS.DIA.  In the file, MINS.DIA, you 
can choose two minerals to be plotted in the diagram. You enter string variables like OPX or cpx 
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(the logic is case insensitive) near the beginning of the plot definition. Igpet will not plot 
anything unless the opx or CPX strings are present in the sample name. It doesn't have to be the 
entire name, just part of it (e.g. "Sal-SA-206 cpx core"). There are also mineral strings in the PCS 
files. So, you should to coordinate your mineral sample names with the mineral strings in 
MINS.DIA and the PCS files.  
 
One complex diagram, the Lindsley and Anderson (1983) two pyroxene geothermometer, is 
included.  It  is limited to cpx and Fe++/Fe+++ is determined by charge balance. 
 
CMAS Projections  
There are many ways to transform the major elements into the four end-members, C, M, A and S. 
Elthon (1983) provides a lucid review. The textbook "The Interpretation of Igneous Rocks" by 
Cox, Bell and Pankhurst (1979-Allen and Unwin, London) has good graphical depictions of 
projections. O'Hara (1976) describes the advantages of "pseudoquaternary isostructural molecular 
equivalent weight projections". Grove and Baker (1984) suggest that projections should be on an 
oxide basis, rather than a molar or weight basis. There is no agreement on how best to employ 
the many projections that exist. Different ones may be suitable for different circumstances.  To 
pursue this, I suggest starting with O'Hara (1976).  
 
The Phase boundaries in the Grove plagioclase projection include the results of Sack et al. 
(1987). This results in a straighter cpx-ol boundary, near the cpx-ol sideline. 
 
Earlier versions of Igpet had separate CMAS and Projection routines. Now they are combined 
into a single expression. This is generally the way they are presented in the literature, so as new 
projections are devised they will be easy to incorporate. 
 
Spider Diagrams 
Basic references on Spider Diagrams are Thompson (1982), Thompson et al. (1984), and Wilson 
(1989). The special buttons for spider diagrams are: 
 Repick means go back to the list of analyses and pick a new subset. 
 New Spi. returns you to the list of available diagrams (data is in SPIDER.DIA). 
 Y-Scale  lets you reset the y-axis limits and switch to a linear axis. 
 
Mixing and Mixing  
In the Mix option in XY plots Igpet's logic follows Langmuir et al. (1977) and calculates the 
coefficients of the hyperbola equation. This allows the mixing line to be extended beyond the 
selected endpoints. For isotopic ratios the ppm value of the element is sought in the data fields. If 
it isn't found the routine terminates. For Sr, the routine uses the ppm value, the relative 
abundances of non-radiogenic Sr isotopes and the 87/86 ratio to calculate ppm 87Sr and ppm 86Sr. 
These values for each endpoint go into the equation for determining the coefficients of the 
hyperbola.  For Nd and Pb the same routine is followed. In plots of Pb ratio versus Pb ratio, the 
mixing curve should be a line because 204Pb is the denominator on both axes.  
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The mixing line, calculated in the model option, is identical to the line in the Mix option between 
the endpoints, but can't extend beyond them. In the model option the program makes small steps 
between the endpoints and calculates each element in the mix separately. The hyperbola equation 
is not involved. 
 
A third mix option is available in Spider diagrams, see above. 
 
AFC Modeling 
This option will be unclear unless you have a copy of DePaolo (1981) as a guide. The file, 
DEPAOLO.ROC, will allow you to reproduce DePaolo's figure 3.  Not all of DePaolo's equations 
are included in Igpet. 
 
Adding tie lines 
The parameter that controls symbols (usually Kcode) uses integers between 0 and 16. To draw a 
tie line between two points, let the symbol parameter of the second point be a negative number. 
The symbol routine really looks at the absolute value of the integer and uses the sign to key a pen 
up before moving command. 
 
 

Common Problems 
 

Zeros are not plotted 
In all the graphs X, Y, or Z values of zero are not plotted, because in most data sets 0 means not 
determined or below detection limit.    
 
 
Errors in a data file 

If Igpet fails to completely read a file, the matrix limits may have to be changed or the file may 
be corrupt. A corrupt file has either too many or too few elements in some analysis. To find out 

where the problem is, go immediately to the File Operations menu and select Modify. You 
should be able to track down the error by locating where the data become out of place. 

Sometimes the only error is a few invi sible extra lines or spaces at the very end of a file.  When 
you have located the error, use Notepad to fix the problem.
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MIXING.EXE 
 
This program makes petrologic mixing calculations using least squares regression of the major 
elements, after Bryan et al., (1969). Trace element calculations are made, based on the major 
element solution. Many researchers use this technique to test the plausibility of models of crystal 
fractionation or magma mixing.  What criteria to use to judge whether a model is permissible is 
debatable and can vary with the problem being addressed.  In general, the residuals (the 
difference between observed and calculated) should be within analytical error.  However, low 
residuals are no guarantee that the model is successful.  The high degree of covariation of major 
elements really means that there are few degrees of freedom and it allows successful appearing 
fits of some nonsense models.  The best you can say of a model with low residuals is that it has 
not been rejected, but it certainly can not be proved with this technique.  The good news is that a 
great many models fail and can be rejected, so this a valuable tool within its limits. 
 
To start MIXING, click on the MIX icon. 
 
MIXING starts with its main menu. First read a partition coefficient file (PCS), then a weights 
for oxides file (MWT), a rock file and a mineral file.  You can read new mineral, rock or PCS 
files at any time. 
 
The PCS files hold the partition coefficient data needed for trace element calculations. The MWT 
files hold the weighting values for the major oxides. Even if you are not interested in trace 
element calculations, select a PCS file and MWT file.  Different partition coefficient files should 
be created for different types of rock suites. Select the PCS file you want (e.g. Gill.PCS) 
 
A button at the lower left lets you list the PCS and MWT data. Check it for correctness. The 
mineral abbreviations at the top of the matrix are strings that will be looked for in each sample 
name in the mineral file you read. These strings have to be somewhere in the mineral names for 
MIXING to tie a set of partition coefficients to the mineral. In Gill.PCS plagioclase is "pl". Thus, 
a plagioclase in a mineral file has to have "pl" somewhere in its name to have the correct 
partition coefficients tied to it (e.g. "CN9PLAN75"). 
 
The weight for each oxide data allow you to reduce the effect of the overwhelming predominance 
of SiO2 and Al2O3 in most analyses. Before least squares calculation, each oxide will be 
multiplied by its "weight". The analyses are then printed in unweighted form, but the residuals 
and sum of squares of residuals are weighted values. If a MWT file has weights of 0.4 for silica 
and 0.5 for alumina, there will be a discrepancy for these oxides between the difference between 
the Observed and Calculated magmas and the calculated (weighted) residual. You can change the 
weights to 1.0 to eliminate this, but then you will be giving silica and alumina more control over 
the result. You can also give an oxide a weight of 0.0 and it will not contribute to the least 
squares solution. Fe2O3 is multiplied by 0.8998 added to FeO and subsequently ignored. 
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Now all the data are in place and you can begin making models. If you are trying Cerroneg.ROC 
and CN.MIN, you can find published examples in Walker and Carr (1986). The usual model is 
Fractional Crystallization (Fract. Xtl.) 
 
First, pick minerals. It's unwise to pick two or more of the same minerals, e.g. two olivines. 
Second, pick a daughter 
Third, pick a parent. (You can reverse these if you prefer.) 
 
the general equation is: 
  parent = (C1, C2, C3,..., Cd) * (min1, min2, min3,...., daughter) 
and Mixing solves for the coefficients (C's).   
 
The result is seen as soon as you finish your selection.  Output goes first to the screen, but you 
can send a copy to the printer, a text file or a corrected rock file.  The last option allows you to 
build a ROC file of fractionation corrected data, which is useful for trace element modeling. 
 
If you are familiar with an older version of Mixing, there is one significant change.  Mixing now 
reads the Oxide and Oxide weights in the MWT (weighting) files as entire lines. These data used 
to be fixed to 11 oxides in a particular order. Now the order is flexible and up to 15 oxides can be 
used AS LONG AS ALL ARE ON THE SAME LINE. THE LOGIC ONLY READS ONE LINE 
OF OXIDES.  The weights must be on a separate line.  This change is not a big deal, but it 
allows Cr2O3 and NiO to be added.  Fe2O3 should be eliminated because the program 
automatically converts all Fe2O3 to FeO.  The order of the oxides in this line is the order they will 
be printed in the output. 
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APPENDIX A: CONTROL FILES 
 
IGPREF.INI and IGPET.DAT 
Modify IGPREF.INI with the Preferences menu and resize matrix menu. IGPET.DAT is data, 
shown below, that can be left as is. 
 
60.0848,79.899,101.961,159.692,71.846,70.9374,40.311,56.0794,61.979 
94.2,141.95,74.71,151.9902,18   molecular wts of 14 oxides 
1,1,2,2,1,1,1,1,2,2,2,1,2,2     # of cations for same 14 oxides 
26.77,21,37.8,52,12.5,14,11.15,16.05,27.86,43.95,0,27 partial molar volumes 
"SiO[2]","TiO[2]","Al[2]O[3]","Fe[2]O[3]","FeO","MnO","MgO","CaO","Na[2]O" 
"K[2]O","P[2]O[5]","NiO","Cr[2]O[3]","H[2]O+","H[2]O-","CO[2]","SO[2]" 
Si,Ti,Al,Fe,Fe,Mn,Mg,Ca,Na,K,P,Ni,Cr,H,H,C,S 
4674,5995,5292,6994,7773,7745,6028,6901,7418,8301,4362,7858,6842,1111,1111 
2727,5005              # to convert oxides to % 
AN,Q,or,ab,an,lc,ne,kal,C,di,hy,wo,ol 
ac,mt,il,hem,ti,ap,cc,pero,wus,ru,KMS,NMS,COS      CIPW names 
-2.15,0,-8.35,0,-4.5,0,-5.44,.07,3.54,4.19,0,0,0,0   Sack et al. data  
40  the 40 names below are used by Igpet to convert say ba to Ba or RB to Rb. 
You can add to this list but you must change the 40 to the new sum. 
{87}Sr/{86}Sr,{143}Nd/{144}Nd,{206}Pb/{204}Pb,{207}Pb/{204}Pb,{208}Pb/{204}Pb 
{10}Be,Be,Li,"H[2]O+","H[2]O-" 
Rb,Ba,Sr,Cr,Ni,Cu,Zr,Hf,Nb,Ta 
La,Ce,Pr,Nd,Sm,Eu,Gd,Tb,Dy,Ho 
Er,Tm,Yb,Cs,Th,Pb,Co,Zn,Sc,Ga 
 
DEFAULT.NRM  normalization used in S-Norm in variable calculator, set the file you want in 
the preferences window 
'Sun and McDonough 1989  primitive mantle 
Cs,.0079 
Tl,.005 
Rb,.635 
Ba,6.989 
W,.02 
Etc. 
 

PAGE.DIA  controls where Igpet draws its plots on a page there are 16 options. 
8500,11000,"page width, height in Portrait mode in 1000's of inch 
16 
"Portrait",    2000,4000,7000,7500,"XYL" 
"Portrt-Upper",2000,6500,7000,10000,"XYL" 
"Portrt-Lower",2000,2000,7000,5500,"XYL" 
"Portrt-UUL",  1400,7200,3900,8950,"-YL" 
"Portrt-MUL",  1400,5300,3900,7050,"-YL" 
"Portrt-LML",  1400,3400,3900,5150,"-YL" 
"Portrt-LLL",  1400,1500,3900,3250,"XYL" 
"Portrt-UUR",  4100,7200,6700,8950,"-YR" 
"Portrt-MUR",  4100,5300,6700,7050,"-YR" 
"Portrt-LMR",  4100,3400,6700,5150,"-YR" 
"Portrt-LLR",  4100,1500,6700,3250,"XYR" 
"Lndscp-Page", 2500,2500,9500,7500,"XYL" 
"Lndscp-LL",   1500,1700,5000,4200,"XYL" 
"Lndscp-LR",   5500,1700,9000,4200,"XYR" 
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Symbol Files or sym files 
 
TTSYMS.SYM  stands for two-toned symbol file. Widths and lengths are in 1000s of an inch. 
The first two lines are special, the rest of the lines have a common format, one (or more) line per 
symbol.  Circles and polygons have slightly different formats, but both begin with 6 integers that 
specify the color of the line, first 3, and the fill, second 3.  Polygons have an integer that specifies 
the number of points in the polygon. 
 
.7,13  scale factor for symbols, thickness of outer line in 1000’s of inch 
19     number of symbols in file 
0,0,0,0,0,0,"CIRC",1,30,30 
[red,green,blue]line color,[red,green,blue] fill color, circle, 1 apex, radius of 30, dummy 
0,170,85,255,255,255,"POLY",4,130,-74,0,152,-130,-74,130,-74 
[red,green,blue]line color,[red,green,blue] fill color, polygon, 4 apexes, x1,y1,x2,y2,etc (triangle) 
0,170,85,75,255,175,"FPOLY",4,130,-74,0,152,-130,-74,130,-74 
same as previous but polygon is filled 
more examples follow 
0,0,200,255,255,255,"POLY",5,-112,-112,112,-112,112,112,-112,112,-112,-
1120,0,200,175,175,255,"FPOLY",5,-112,-112,112,-112,112,112,-112,112,-112,-112 
200,0,200,255,255,255,"POLY",5,100,0,0,160,-100,0,0,-160,100,0 
200,0,200,245,0,245,"FPOLY",5,100,0,0,160,-100,0,0,-160,100,0 
225,0,0,255,255,255,"CIRC",1,112,112 
225,0,0,255,0,0,"FCIRC",1,112,112 
several lines deleted  
255,128,0,255,200,0,"FPOLY",17,50,50,50,100,0,150,-50,100,-50,50,-100,50,-
150,0,-100,-50,-50,-50,-50,-100,0,-150,50,-100,50,-50,100,-
50,150,0,100,50,50,50 
0,0,0,0,0,0,"CIRC",1,40,40 
0,0,0,15,"tickpen color-RGB,width" 
0,0,0,20,"mixmodpen color-RGB,width" 
255,255,255,99,"pagecolor" 
255,255,220,99,"boxcolor" 
0,0,0,99,"textcolor" 
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SPIDER.DIA  This file controls spider diagrams. 
 
"REEs-Nakamura, 1974",Chondrites 'title, normalization factor 
15,x,1,1000    '# of elements, no double norm, ystart, yend 
La,Ce,Pr,Nd,Pm,Sm,Eu,Gd,Tb,Dy,Ho,Er,Tm,Yb,Lu 
.33,.865,.112,.63,1,.203,.077,.276,.047,.343,.07,.225,.03,.22,.034 
"Thompson, R.N., 1982-double","Chondrites" 
19, "Yb=10",1,1000   'double norm. to Yb=10, " "s needed 
Ba,Rb,Th,K,Nb,Ta,La,Ce,Sr,Nd,P,Sm,Zr,Hf,Ti,Tb,Y,Tm,Yb 
6.9,.35,.042,120,.35,.02,.328,.865,11.8,.63,46,.203,6.84,.2,620,.052,2,.034, 
"Mg-norm Minors & Majors"," CI (A&G)" 
13,"Mg=1",.001,10   'double norm. to Mg= 1, " "s needed  
Ca, Al, Ti, Mg, Si, Cr, Mn, K, Na, Fe, Ni, P, S 
9280,8680,0436,98900,106400,2660,1990,0558,5000,190400,11000,1220,62450 
"Wood, D.A. et al., 1979","Primordial Mantle" 
19,x,1,1000 
Cs,Rb,Ba,Th,U,K,Ta,Nb,La,Ce,Sr,Nd,P,Hf,Zr,Sm,Ti,Tb,Y 
.019,.86,7.56,.096,.027,252,.043,.62,.71,1.9,23,1.29,90.4,.35,11,.385 
1527,.099,4.87 
"Sun (1980)","Chondrites" 
16,x,1,1000 
Rb,Ba,Th,U,Nb,Ta,K,La,Ce,Sr,Nd,Sm,Zr,Ti,Gd,Y 
.35,3.8,.05,.013,.35,.02,120,.315,.813,11,.597,.192,5.6,620,.28,2 
"Pearce, 1983","MORB" 
15,x,.1,100 
Sr,K,Rb,Ba,Th,Ta,Nb,Ce,P,Zr,Hf,Sm,Ti,Y,Yb 
120,1245,2,20,.2,.18,3.5,10,534,90,2.4,3.3,8992,30,3.4  
"Hickey/Frey 1986","Bulk Earth" 
15,x,1,1000 
Cs,Rb,Ba,Th,K,Nb,La,Ce,Sr,Nd,Zr,Sm,Ti,Y,Yb 
.012,.35,3.5,.042,120,.39,.31,.81,11,.602,5.6,.196,620,2.2,.21 
"Sun/McDon. 1989-PM","Primitive Mantle" 
22,x,1,1000 
Cs,Rb,Ba,Th,U,Nb,K,La,Ce,Pb,Pr,Sr,P,Nd,Zr,Sm,Eu,Ti,Dy,Y,Yb,Lu 
.0079,.635,6.989,.085,.021,.713,250,.687,1.775,.071,.276,21.1,95,1.354,11.2,.4
44,.168,1300,.737,4.55,.493,.074 
"Semark Chond.","CI" 
9,"Si=1",.02,10   ‘double norm to Si=1, " "s needed 
Ca, Al, Ti, Mg, Si, Cr, Mn, Na, K 
14100,15900,0700,159200,222500,3400,2200,7400,0600 
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*.DGM files 
These files allow for predefined diagrams. The control data differentiate XY vs. TRI diagrams, 
define the X, Y, and Z parameters, define dimensions, and labels. Some diagrams are complex. 
Look at some examples, drawn from various .DGM files, to learn how to mimic them. Replace 
"XY" with "XYSMALL" if you want small fonts for interior labels. 
 
"AFM","Irv.+Baragar 1971","thol vs calc-alk" 'name, source, remark or note 
"TRI"       'a triangular diagram 
"Alk",Na2O,1,K2O,1,END    'see *** below 
"FeO*,"FeO,1,Fe2O3,.8999,END   'see *** below 
"MgO",MgO,1,END     'see *** below 
0,1,0,1,0,1      'xmin,xmax,ymin,ymax,zmin,zmax 
25       '# of points defining fields 
0.686,0.294,1      'x,y,pen  (1=pen down 0=pen up) 
0.646,0.314,1      etc 
0.593,0.347,1,0.534,0.386,1    etc 
…… 
2       '# of labels 
.7,.15,"Calc-Alkaline"     'x,y, label-1   
.3,.6,"Tholeiitic"     'x,y, label-2 
 
*** The three lines that define the parameters begin with the variables name, followed by each 
oxide or element name and its coefficient. The parameter is terminated with END. 
Thus "Alk" = Na2O+K2O  "FeO*" = FeO+.8999*Fe2O3. 
 
It is important that the Oxide or Element names used here are the same ones used in the 
data files. IGPET will compare names on an all capitals basis with {, }, [, ] stripped out. 
 
The following example shows how to accommodate division (A/B). 
 
"%An-Al2O3","Irv.+Baragar 1971","thol-calc-alk" 'name, source, remark or note 
"XY"       'an XY diagram 
"AN"       'variable name - AN 
an,100       'part one of x-variable (100*an) 
"/" 'if / (or *) appears rather then a field name, then divide (multiply) part one by part two 
an,1,ab,1,ne,.6,END     'part two of x-variable (an+ab+.6*ne) 
"Al[2]O[3]",Al2O3,1,END    'y-variable, (name, oxide, coeff.,end)  
0,100,40,10,10     'x-axis is linear(0), from 100 to 40 
       'tick interval of 10, labels every 10  
0,10,25,1,5      'y-axis{linear,begin,end,tickstep, labelstep} 
7       '# of points defining fields 
40.,15.2 ,1,50.,16. ,1 ,60.,16.8,1, 70.,17.6,1 
80.,18.4 ,1,90.,19.2,1,100.,20.0,1 
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The following example allows you to draw a box shape and use a log scale for x and y. 
"Y+Nb vs Rb","Pearce et al. 84","tectonic"  'name, source, remark or note 
"XY Box"      'special form of XY, a Box 
"Y+Nb",Y,1,Nb,1,END    'defines x 
"Rb",Rb,1,END     'defines y 
1,2,2000,0,0      'x-axis 1=logscale, from 2 to 2000, 0,0 
1,1,2000,0,0      'y-axis{scale,begin,end,dummy,dummy} 
7       '7 x,y,pen points to plot lines with 
2,80,0,55,300,1,400,2000,1,55,300,0,50,1,1,51.5,8,0,2000,400,1 
4       '4 interior labels 
5,750,"syn-COLG",300,600,WPG,6,3,VAG,300,8,ORG 
 
*.CMA files 
The format of these files is almost the same as that for the DGM triangular files. There are three 
added data, the final apex scaling values. These numbers follow the apex names. They can be in 
molar, weight or oxygen units. 
 
"Plag. Proj.","Baker and Eggler","mole"  'name, remark or note, units  
"TRI"      'a triangular plot 
Ol,1      'left apex name, scaling value (1 -mole units) 
Al2O3,.5,Fe2O3,-.5,FeO,.5,MnO,.5,MgO 
.5,CaO,-.5,Na2O,-.5,K2O,-.5,end  'the equation 
Di,1      'top apex, etc 
Al2O3,-1,CaO,1,Na2O,1,K2O,1,end  'equation for top apex  
"Qz+Or",1     'right apex,etc 
SiO2,1,Al2O3,-.5,Fe2O3,.5,FeO,-.5,MnO 
-.5,MgO,-.5,CaO,-1.5,Na2O,-5.5,K2O,-3.5,end 
0,1,0,1,0,1     'xmin,xmax,ymin,ymax.xmin,zmax -a full triangle 
0,1      'no interior lines,'1 extra label 
.5,-.07,"Opx"     'extra label 
"Di to En-Pl-Q","Merz.+Eggler","mole" 'second example 
"TRI" 
"En-50",1 
Al2O3,1,Fe2O3,-1,FeO,1,MnO,1,MgO,1,CaO,-1,Na2O,-1,K2O,-1,end 
"Pl-60",1 
Al2O3,1,Na2O,1,K2O,-1,end 
"Q+Or-90",1 
SiO2,1,Al2O3,-1,Fe2O3,1,FeO,-1,MnO,-1,MgO,-1,CaO,-1,Na2O,-5,K2O,-3,end 
0,.5,.1,.6,.4,.9     'only a small part of triangle is drawn 
0,0 
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*.CMA files continued 
      'third example 
"Plag. Proj.","Grove etal 84; Sack etal 87","Oxygens" 
"TRI" 
Ol,4      '4 Oxygens for Ol 
TiO2,-1,Al2O3,.5,Fe2O3,1,FeO,.5,MgO,.5,CaO 
-.5,Na2O,-.5,K2O,-.5,Cr2O3,-.5,end 
Di,6      '6 Oxygens for Di 
Al2O3,-1,CaO,1,Na2O,1,K2O,1,end 
Q,2      '2 Oxygens for Q 
SiO2,1,TiO2,1,Al2O3,-.5,Fe2O3,-1,FeO,-.5,MgO 
-.5,CaO,-1.5,Na2O,-5.5,K2O,-5.5,Cr2O3,.5,end 
0,1,0,1,0,1 
22      '22 line segments drawn 
.29,.71,0,.29,.58,1,.285,.43,1,.285,.39,1,.275,.325,1,.25,.27,1,.26,.2,1 
.27,.09,1,.27,0,1,.146,0,0,.165,.065,1,.21,.18,1,.25,.27,1,.08,0,0,.10,.09,1 
.12,.17,1,.14,.24,1,.16,.3,1,.19,.36,1,.22,.40,1,.25,.42,1,.285,.43,1 
0      'no extra labels 
 
 
EXTRA.DIA 
Parameters that are automatically calculated and added to the variable list when the file 
operations, extra menu is selected. Also calculated in this routine is density, after Bottinga and 
Weill (1970) on a water-free, 1 atm, 1200 C basis. 
  
"FeO*"   'name      
FeO,1,Fe2O3,.8998,end 'FeO*=FeO+.8998*Fe2O3  
"Mg#"    'name  
MgO,2.481,"/"   'part1 is 100*Mg0/40.32 
MgO,.0248,FeO,.013918,Fe2O3,.012523,end 
    'part 2 is MgO/40.32 + FeO/ 71.85 +2*Fe2O3/159.7 
    'end signifies the end of the equation 
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PEARCE.DIA 
 
Pearce diagrams are based on element proportions, E. 
    E= (wt% * # of cations)/molecular wt. 
These are calculated for all the oxides in the Pearce subroutine. The data file consists of 
meaningful combinations of these element proportions. Consult Stanley and Russell (1989) for 
the appropriate use of these parameters. 
 
"K", K2O,1,end  'K=K2O  , a conserved constituent.   
"Ti",TiO2,1,end  'label, oxide, coefficient 
"Si",SiO2,1,end 
"Al",Al2O3,1,end 
"0.5(Mg+Fe)",FeO,.5,MgO,.5,end  
"OL+CPX+PL",CaO,1.5,Al2O3,.25,FeO,.5,MgO,.5,Na2O,2.75,end 
"Ca+0.5(Na-Al)",CaO,1,Na2O,.5,Al2O3,-.5,end 
 
MINS.DIA 
 
This file sets up a few mineral plots. The first plot is elaborate and must always be the first plot 
in MINS.DIA.  This is the geothermometer of Lindsley and Anderson (1983). 
Some complicated logic is built into IGPET to calculate this and the logic depends on this plot 
being the first mineral plot. The other mineral plots are rather plebeian. The Lindsley Anderson 
geothermometer lacks calculation subroutines for OPX and PIG. 
 
"Lindsley-Anderson isotherms" Title 
"CPX","CPX"    plots only Cpx  
"TRI"  
"En",MgO,1,END   'X 
"Wo50",CaO,1,END   'Y 
"Fs",FeO,1,MnO,1,END  'Z 
0,1,0,.5,0,1    'xmin,xmax,ymin,ymax,zmin,zmax    
62     '# of points defining fields 
.510,.490,0,.489,.481,1 
.458,.472,1,.431,.469,1 
.389,.461,1,.341,.459,1.....  'first 6 points 
2     'two labels 
.5,.3,"1200 C"    'label 1 
.37,.345,"1000 C"   'label 2 
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*.PCS files 
 
These files are control files for MIXING.EXE. They have the partition coefficient data. Values 
shown here are from Gill (1981).   
 
Note: Tab delimited data so easily read and manipulated in Excel. 
 
el/min PL CPX OPX OL HB MT GA IL 
K 0.11 0.02 0.01 0.01 0.33 0.01 0.01 0.01 
Rb 0.07 0.02 0.02 0.01 0.05 0.01 0.01 0.01 
Sr 1.8 0.08 0.03 0.01 0.23 0.01 0.02 0.01 
Ba 0.16 0.02 0.02 0.01 0.09 0.01 0.02 0.01 
Zr 0.01 0.25 0.1 0.01 0.4 0.4 0.5 0.4 
Ni 0.01 6 8 58 10 10 0.6 10 
Cr 0.01 30 13 34 30 32 22 32 
 V 0.01 1.1 1.1 0.08 32 30 8 30 
 
 
*.MWT files 
 
These files are control files for MIXING.EXE. They have the weighting scheme for the oxides.  
 
SiO2","TiO2","Al2O3","FeO","MnO","MgO","CaO","Na2O","K2O","P2O5","NiO","Cr2O3"
.4,1,.5,1,1,1,1,1,1,1,1,1 
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APPENDIX B: DATA FILES 
 
COTLO.ROC contains glasses that were formed in equilibrium with Plag-Cpx-(Ol or Opx). 
These glasses trace the 1 atm pseudo- quaternary cotectic that exists at the intersection of the 
primary phase volumes of these minerals. There is a problem in locating this intersection because 
additional components, especially K2O and Na2O, appear to cause large shifts in the location of 
this intersection. Different CMAS projections cause different shifts. The problem is to determine 
how much of the shift is real and caused by thermodynamic effects and how much is an artifact 
of projection. This is an important problem that needs to be resolved in order to better interpret 
real rocks projected into these diagrams.  
  
The different Key numbers in this file stand for different data sources. 
 
key symbol    ref. 
 
 1. open triangle   Walker et. al., 1979 
 2. filled triangle   Grove and Bryan, 1983 
 3. open box   Baker and Eggler, 1983 
 8. filled circle   Grove et al., 1982 
 
 
COTHI.ROC contain glasses that were in equilibrium with a dry peridotite sandwich at various 
pressures. For a complete discussion read Takahashi and Kushiro (1983), the source of most of 
the data. One data point, plotted as a "X", is from Baker and Eggler (1983). This point represents 
about 8 kb and an unspecified small per cent H2O. It was not in equilibrium with a peridotite 
sandwich. Because of the water and the type of experiment, it is not strictly comparable to the 
rest of the data.  
 
The different Key numbers refer to pressures. 
 
Key symbol  pressure (kb)   1 Gpa=10 kb 
 
 1. open   triangle  5   0.5 
 2. filled triangle  8   0.8 
 3. open   box  10   1.0 
 4. filled box  10-10.5  1.0-1.05    
 5. open   diamond 20   2.0 
 6. filled diamond  25   2.5 
 7. open   circle  30   3.0 
 8. filled circle  35   3.5 
11.      X   8 (wet)   0.8 (wet) 
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VGGP.TXT   MORB glass data set provided by Melson et al. (1977). It is a large file of 
high quality probe analyses of mid ocean ridge glasses from dredge hauls.  
 
Several other data files refer to studies of Central American volcanoes. 
 
FUSAMA.TXT 
 Fuego   key=1, see: Chesner and Rose (1984) 
 Santa Ana  key=7, see: Carr and Pontier (1981) 
 Masaya     key=3, see: Walker et al. (1993) 
 
CERRONEG.TXT 
 Cerro Negro volcano in Nicaragua, see: Walker and Carr (1986) 
 
CN.MIN 
 see above: this file has mineral analyses from Cerro Negro volcano, Nicaragua 
 
IZALCO.TXT 
 see: Carr and Pontier (1981) on Izalco volcano, El Salvador 
 
BOQUERON.TXT 
 see: Fairbrothers et al. (1978) on Boqueron volcano, El Salvador 
 
CENTAM.TXT 
 see: Carr et al. (1990) 
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